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User Manual

User Setup

Step 1: Register a Company Account

To register a company, simply follow these easy steps:

Go to https://myfridgeonline.com/register1.
Fill out the required fields and accept the terms and conditions, once complete, click on2.
Proceed.

You will then be prompted to enter a One Time Pin. This One Time Pin will be sent to you via the3.
email address entered in the registration form. Simply enter the One Time Pin and click Verify.

https://myfridgeonline.com/register
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Afterwards, you will be directed to the completion page. Once here, your account will be4.
created, but not activated just yet. To activate your account, you will need to purchase or
redeem a subscription.

Clicking Proceed To Store will route you to our Shopify page where you can purchase a5.
subscription.
Clicking Redeem will open a code redemption dialog in which you can enter your subscription6.
code.
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After either purchase of a subscription, or redemption of a subscription voucher, your account7.
will be activated. You can then click on Login to route to the login page where you can enter the
website with your details provided during registration.

Video Guide

Watch the following video on how to register an account.

Video

Registering a User Account

If the company you are joining already exists, you will need to request an invitation from an
administrator. You will receive an email prompting you to accept the invitation. Simply click the
Accept button and you will be redirected to the registration page. Fill out the required fields and
accept the terms and conditions, once complete, click on Submit. You will then be redirected to the
login page where you can enter the website using your details provided during registration.

https://www.youtube-nocookie.com/embed/mDnoqgmXAYM?si=4SUakioD79fDaXa7
https://www.youtube-nocookie.com/embed/mDnoqgmXAYM?si=4SUakioD79fDaXa7
https://docs.myfridgeonline.com/_media/products/smrtcold/user_invite_carel.png
https://docs.myfridgeonline.com/_media/products/smrtcold/user_invite_carel.png
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The SMRT Cold Label

QR Code for setup instructions1.
The subscription voucher code. This is used to add a subscription to your account.2.
Device information. Includes Serial Number (SN). This is used to register device.3.
QR code used to register device by scanning4.

Step 2: Registering a Device
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Register Device by scanning QR Code (Auto)

In order to register your device, scan the QR code on the right side of the label. You will then be1.
redirected to the device registration page.
Here the table will be pre-populated with your device serial number. Simply click on the2.
Register Devices button in order to register your device.
The device will then be added to your account.3.

Register Device with device serial number (Manual)

Navigate to the www.myfridgeonline.com.1.
Then navigate to the devices page. The Devices page can be accessed from the side navigation2.
bar by clicking on Devices.
Click on the '+' icon (register device) to access the Register Device page.3.

http://www.myfridgeonline.com
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Enter the serial number of the device (located on the sticker attached to the device) into the4.
dialog box and press the enter key or click on the '+' icon.

The serial number will then be entered into the table. Step 4 can be repeated if multiple devices5.
are to be registered. Once complete click 'Register Devices' to complete registering devices to
your account and your devices will then be displayed on the Devices page.
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Video Guide

Watch the following video on how to register a device to your account.

Video

Step 3: Create a Device Pool

The Device Pool page can be accessed from the side navigation bar by clicking on the Devicepools tab
and clicking Devicepools. Clicking the '+' icon (top right) will open the Create Device Pool dialog. This
will allow you to create a device pool.

https://www.youtube-nocookie.com/embed/mP_xF-WCchM?si=Q3VXikNFSLd8sdeE
https://www.youtube-nocookie.com/embed/mP_xF-WCchM?si=Q3VXikNFSLd8sdeE
https://docs.myfridgeonline.com/_detail/user_manual/devicepools/devicepools_page/devicepool_page_-_add_highlight.png?id=products%3Asmrtcold%3Agetting_started
https://docs.myfridgeonline.com/_detail/user_manual/devicepools/devicepools_page/devicepool_page_-_add_highlight.png?id=products%3Asmrtcold%3Agetting_started
https://docs.myfridgeonline.com/_detail/user_manual/devicepools/devicepools_page/devicepool_page_-_add_highlight.png?id=products%3Asmrtcold%3Agetting_started
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Naming the Device Pool

Here simply enter the name of the device pool and click Submit.

Video Guide

Watch the following video on how to create a devicepool.

https://docs.myfridgeonline.com/_media/products/smrtcold/device_pool_creation_-_config.png
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Video

Step 4: Allocate the Device to a Device Pool

Navigate back to the Devices page to allocate the device pools that you have just created.

Selecting the Devices

Device Pools can be allocated to a device by selecting the checkbox. This can also be done for
multiple devices. Doing so will cause the Allocate Device Pool button to appear. Clicking this will open
the Allocate Devices dialog.

Allocating Device Pools

You can view the currently selected devices from the Devices field.

https://www.youtube-nocookie.com/embed/QkaA0MCP40w?si=n5pO2Ox6JJlWNj5I
https://www.youtube-nocookie.com/embed/QkaA0MCP40w?si=n5pO2Ox6JJlWNj5I
https://docs.myfridgeonline.com/_media/user_manual/devices/devices_page/device_page_device_selected_-_allocate_highlight.png
https://docs.myfridgeonline.com/_media/user_manual/devices/devices_page/device_page_device_selected_-_allocate_highlight.png
https://docs.myfridgeonline.com/_media/user_manual/devices/devices_page/device_page_device_selected_-_allocate_highlight.png
https://docs.myfridgeonline.com/_media/products/smrtcold/device_devicepool_dialog_-_devices.png


Last update: 2025/05/01 12:14 products:smrtcold:getting_started https://docs.myfridgeonline.com/products/smrtcold/getting_started

https://docs.myfridgeonline.com/ Printed on 2025/07/24 04:56

Your currently created device pools will be displayed by clicking the device pool field. Selecting a
device pool from here will add it to the list of device pools. Multiple device pools can be selected this
way.

Once the device pools have been selected, they will be added to the device pool field.

https://docs.myfridgeonline.com/_media/products/smrtcold/device_devicepool_-_selection_open_no_create.png
https://docs.myfridgeonline.com/_media/products/smrtcold/device_devicepool_-_selection_open_no_create.png
https://docs.myfridgeonline.com/_media/products/smrtcold/device_devicepool_-_selection_open_no_create.png
https://docs.myfridgeonline.com/_media/products/smrtcold/device_devicepool_-_multiple_selected.png
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Click Submit to complete device pool allocation.

Video Guide

Watch the following video on how to allocate a device to a devicepool.

Video

Step 5: Invite Users to the Company

The Users page can be accessed from the side navigation bar by clicking on the Users tab then
clicking on Users. Clicking the '+' icon (top right) will open the Invite User dialog. This will allow you to
invite new users to your company.

https://www.youtube-nocookie.com/embed/NbbaW6Prjlg?si=4c7RLpj3UiEh0xk_
https://www.youtube-nocookie.com/embed/NbbaW6Prjlg?si=4c7RLpj3UiEh0xk_
https://docs.myfridgeonline.com/_media/user_manual/users/users_page/users_page_-_user_invite_highlight.png
https://docs.myfridgeonline.com/_media/user_manual/users/users_page/users_page_-_user_invite_highlight.png
https://docs.myfridgeonline.com/_media/user_manual/users/users_page/users_page_-_user_invite_highlight.png
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You can select a role for the user you wish to invite from the drop down menu. The list of available
roles may vary based on your current role. The User role has read-only access to device pools that
they have been assigned. The Manager role has limited edit access to devices, alert groups and
reports and can only see device pools that they have been assigned. The Company Owner role has
full access to all options.

https://docs.myfridgeonline.com/_media/user_manual/users/invite_user/user_invite_role_open.png
https://docs.myfridgeonline.com/_media/user_manual/users/invite_user/user_invite_role_open.png
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You can select a dashboard type from the dashboard drop down menu. This will affect what the new
user will see when 'Dashboard' is selected from the side navigation menu. There are currently two
types of dashboards:

Sensor Dashboard - This is the default dashboard which displays sensor information. Device
Dashboard - This dashboard is used primarily for SMRTCloud devices.

N.B: This will only apply to new users. Users who already have an account will not have this setting
applied.
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After clicking submit, an email will then be sent to the user prompting them to accept the invitation.
This will then navigate the user to a registration page where they can create their account and join
the company.

Video Guide

Watch the following video on how to invite a user to your company.
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Video

Step 6: Allocate Device Pools to Users

The Allocate Users page can be accessed from the side navigation bar by clicking on the Devicepools
tab and clicking Allocate Users.

Allocating a Device Pool

Device Pools can be allocated to a user by selecting the checkbox. This can also be done for multiple
users. Doing so will cause the '+' icon to appear (top right). Clicking on this will open the User
Devicepool Mapping dialog.

Here, users can be allocated to specific device pools. If the user role is User or Manager, they will only
be able to view devices within the device pools which have been allocated to them. Simply select the
device pools you wish to allocate to the selected users and submit when done. Multiple device pools
can be selected.

https://www.youtube-nocookie.com/embed/pQ76s-Zb010?si=lnINzX_snb0fsBvA
https://www.youtube-nocookie.com/embed/pQ76s-Zb010?si=lnINzX_snb0fsBvA
https://docs.myfridgeonline.com/_media/user_manual/devicepools/allocate_users_page/allocate_users_page_devices_selected_-_devices_add_highlight.png
https://docs.myfridgeonline.com/_media/user_manual/devicepools/allocate_users_page/allocate_users_page_devices_selected_-_devices_add_highlight.png
https://docs.myfridgeonline.com/_media/user_manual/devicepools/allocate_users_page/allocate_users_page_devices_selected_-_devices_add_highlight.png
https://docs.myfridgeonline.com/_media/products/smrtcold/user_device_pool_map.png
https://docs.myfridgeonline.com/_media/products/smrtcold/user_device_pool_map.png
https://docs.myfridgeonline.com/_media/products/smrtcold/user_device_pool_map.png
https://docs.myfridgeonline.com/_media/products/smrtcold/user_device_pool_map.png
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Video Guide

Watch the following video on how to allocate devicepools to users.

Video

Step 7: Create an Alert Group

The Alert Groups page can be accessed from the side navigation bar by clicking on the Alerts tab and
then clicking on Alert Groups. Clicking the '+' icon (top right) will open the Create Alert Group dialog.
This will allow you to create an alert group.

https://www.youtube-nocookie.com/embed/pzsY-Fb3TNs?si=r9xqom9w9ylWKCYt
https://www.youtube-nocookie.com/embed/pzsY-Fb3TNs?si=r9xqom9w9ylWKCYt
https://docs.myfridgeonline.com/_media/user_manual/alert_groups/alert_group_page/alert_group_page_-_create_button_highlight.png
https://docs.myfridgeonline.com/_media/user_manual/alert_groups/alert_group_page/alert_group_page_-_create_button_highlight.png
https://docs.myfridgeonline.com/_media/user_manual/alert_groups/alert_group_page/alert_group_page_-_create_button_highlight.png
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Here you can create an alert group which defines what actions will be taken when an alert is
triggered.

Adding an Escalation Event

Clicking on the event name will allow you to edit the event. Clicking the '+' button will allow you to
add an escalation. Up to 3 escalations are allowed.

https://docs.myfridgeonline.com/_media/user_manual/alert_groups/create_alert_group/alert_group_dialog_empty.png
https://docs.myfridgeonline.com/_media/user_manual/alert_groups/create_alert_group/alert_group_dialog_empty.png
https://docs.myfridgeonline.com/_media/user_manual/alert_groups/create_alert_group/alert_group_dialog_empty_-_escalation_hightlight.png
https://docs.myfridgeonline.com/_media/user_manual/alert_groups/create_alert_group/alert_group_dialog_empty_-_escalation_hightlight.png
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Adding a User

Clicking on the User drop down will allow you to select a user from your company. This will be the
user who gets alerted. Event 1 recipient will get the alert 1 minute after the delay set on the sensor.

https://docs.myfridgeonline.com/_media/user_manual/alert_groups/create_alert_group/alert_group_dialog_empty_-_user_time_highlight.png
https://docs.myfridgeonline.com/_media/user_manual/alert_groups/create_alert_group/alert_group_dialog_empty_-_user_time_highlight.png
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Adding Actions

Adding actions defines what type of alerts the selected user will receive. These can be selected from
the drop down menu and added using the '+' button. Multiple actions can also be added by clicking
on the '+' button after each selection.

These actions will then be added to the table. Actions can also be enabled or deleted.

https://docs.myfridgeonline.com/_media/user_manual/alert_groups/create_alert_group/alert_group_dialog_type_open_-_type_highlight.png
https://docs.myfridgeonline.com/_media/user_manual/alert_groups/create_alert_group/alert_group_dialog_type_open_-_type_highlight.png
https://docs.myfridgeonline.com/_media/user_manual/alert_groups/create_alert_group/alert_group_dialog_type_open_-_type_highlight.png
https://docs.myfridgeonline.com/_media/user_manual/alert_groups/create_alert_group/alert_group_dialog_actions_added_-_actions_highlight.png
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After you are done configuring the actions, press submit to save the Alert Group.

Video Guide

Watch the following video on how to create an alert group.

Video

Step 8: Create a Report

The Reports page can be accessed from the side navigation menu by clicking on the Reports tab, then
clicking on Reports. Clicking the '+' icon (top right) will open the Create Report dialog. This will allow
you to create a report.

https://www.youtube-nocookie.com/embed/q7oNIxpgnc4?si=ODamIkQofouAzJY_
https://www.youtube-nocookie.com/embed/q7oNIxpgnc4?si=ODamIkQofouAzJY_
https://docs.myfridgeonline.com/_media/user_manual/reports/reports_page/report_page_-_add_highlight.png
https://docs.myfridgeonline.com/_media/user_manual/reports/reports_page/report_page_-_add_highlight.png
https://docs.myfridgeonline.com/_media/user_manual/reports/reports_page/report_page_-_add_highlight.png
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Report Details

Under report details you can set the name of your report, the timezone which you use and whether
you want a Standard or Advanced report.

Report Schedules

Report schedules allow you to define the time and frequency at which you receive reports. You can
either set your reports to daily, weekly or monthly and set a time and day for each. Frequency log
determines the time interval (in minutes) that a point is recorded on the report. After you are done
selecting your schedule, click the '+' button to add your schedule to the list. Multiple schedules can
be created.

Report Recipients

Report recipients define who will receive the report. Recipients can only be selected from users within
the company, however external recipients can be set for users outside of the current company.
Multiple recipients can be selected from the drop down menu. External recipients can be added by
typing the email address in the Recipients External field then pressing the enter key. To proceed to
Datalogs, click on the on the '>' icon (bottom right).

https://docs.myfridgeonline.com/_media/products/smrtcold/report_create_-_schedules.png
https://docs.myfridgeonline.com/_media/products/smrtcold/report_create_-_schedules.png
https://docs.myfridgeonline.com/_media/products/smrtcold/report_create_-_schedules.png
https://docs.myfridgeonline.com/_media/products/smrtcold/report_create_-_schedules.png
https://docs.myfridgeonline.com/_media/products/smrtcold/report_create_-_schedules.png
https://docs.myfridgeonline.com/_media/products/smrtcold/report_create_-_recipients.png
https://docs.myfridgeonline.com/_media/products/smrtcold/report_create_-_recipients.png
https://docs.myfridgeonline.com/_media/products/smrtcold/report_create_-_recipients.png
https://docs.myfridgeonline.com/_media/products/smrtcold/report_create_-_recipients.png
https://docs.myfridgeonline.com/_media/products/smrtcold/report_create_-_recipients.png
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Report Datalogs

Report Datalogs define which device's data will be displayed on the report. Click on the dropdown to
select the device then add the device using the '+' button. This process can be repeated for all
devices which need to be in this report. After the devices are selected, sensors of the device also
need to be selected.

After a device is added, it will appear below in an expansion panel. This can be clicked to display the
sensor selection for that device. The device's order and how many sensors are selected will also be
displayed here. The device can also be removed from here. You can also click and hold to re-order
devices if multiple devices are selected. This will affect their order in the report datalogs/graph.

Expanding the device panel reveals the sensor selection drop down where multiple sensors can be
selected. A minimum of 1 sensor must be selected per device.

https://docs.myfridgeonline.com/_media/products/smrtcold/report_create_-_datalogs.png
https://docs.myfridgeonline.com/_media/products/smrtcold/report_create_-_datalogs.png
https://docs.myfridgeonline.com/_media/products/smrtcold/report_create_-_datalogs.png
https://docs.myfridgeonline.com/_media/products/smrtcold/report_create_-_datalogs.png
https://docs.myfridgeonline.com/_media/products/smrtcold/report_create_-_datalogs_table.png
https://docs.myfridgeonline.com/_media/products/smrtcold/report_create_-_datalogs_table.png
https://docs.myfridgeonline.com/_media/products/smrtcold/report_create_-_datalogs_table.png
https://docs.myfridgeonline.com/_media/products/smrtcold/report_create_-_datalogs_table.png
https://docs.myfridgeonline.com/_media/products/smrtcold/report_datalogs-_sensor_open.png
https://docs.myfridgeonline.com/_media/products/smrtcold/report_datalogs-_sensor_open.png
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Once sensors have been selected, they will appear in the sensor list. Here, you can click and hold to
drag and re-order sensors. This will affect the order in which they are displayed on the report graph.

A colour can also be selected for the sensor by clicking the coloured circle. This will affect the colour
that the sensor is displayed in, on the report graph.

Report Graphs

https://docs.myfridgeonline.com/_media/products/smrtcold/report_sensor_order.png
https://docs.myfridgeonline.com/_media/products/smrtcold/report_sensor_order.png
https://docs.myfridgeonline.com/_media/products/smrtcold/report_create_color_picker.png
https://docs.myfridgeonline.com/_media/products/smrtcold/report_create_color_picker.png
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Here, report graphs can be configured with a name, type and sensors. Graph type can be selected
from the drop down menu. Currently only line and bar graphs are supported.

Sensors to be displayed on the graph can be selected from the drop down menu. This drop down
menu is populated by the sensors of all selected devices in the Datalogs page. Sensors from different
devices can be graphed against each other.

Once your selection is complete, click on the '+' button to add your graph to the list. If multiple
graphs are added, graphs can be re-ordered. This affects the order in which they are displayed in the
report.

After you are done configuring the graph, press submit to save the report.

Video Guide

Watch the following video on how to create a report.

https://docs.myfridgeonline.com/_media/products/smrtcold/report_graphs.png
https://docs.myfridgeonline.com/_media/products/smrtcold/report_graphs.png
https://docs.myfridgeonline.com/_media/products/smrtcold/report_graphs_sensors_open.png
https://docs.myfridgeonline.com/_media/products/smrtcold/report_graphs_sensors_open.png
https://docs.myfridgeonline.com/_media/products/smrtcold/report_graphs_sensors_open.png
https://docs.myfridgeonline.com/_media/products/smrtcold/reports_graph_table.png
https://docs.myfridgeonline.com/_media/products/smrtcold/reports_graph_table.png
https://docs.myfridgeonline.com/_media/products/smrtcold/reports_graph_table.png
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Video

Device Dashboard

Navigation

The Device Dashboard can be accessed from the side navigation bar by clicking on 'Dashboard'.

NB : By default, the Sensor Dashboard is shown here. The Device Dashboard can only be viewed here
if it is selected in the user settings. This can be done by editing users on the Users page.

https://www.youtube-nocookie.com/embed/QbqGyEMs7dE?si=KLj6w9O72UNTaXJT
https://www.youtube-nocookie.com/embed/QbqGyEMs7dE?si=KLj6w9O72UNTaXJT
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Overview

On the Device Dashboard, information about your SMRTCloud devices will be displayed. Here you can
view your device's status and probe readings. You can also control your device remotely.

https://docs.myfridgeonline.com/_media/products/smrtcold/device_dashboard-_select_closed.png
https://docs.myfridgeonline.com/_media/products/smrtcold/device_dashboard-_select_closed.png
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Devices can be searched and filtered by status using the status drop down menu.

The Device Card

Here you can view your device information such as the device name, serial number and last synced
time. The value currently displayed can be set in the device edit page under 'select display probe'.

Device status is indicated by the card color. This can be one of the following statuses:

Normal - Green
Alert - Red
Offline - Black

If the device is currently in the alert state, the value will then change to display the type of the alert.
The color of the card will also change to indicate this.

Parameter readings are also displayed here. These can be cycled through by clicking the arrow

https://docs.myfridgeonline.com/_media/products/smrtcold/device_dashboard_-_select_open_-_select_highlight.png
https://docs.myfridgeonline.com/_media/products/smrtcold/device_card_-_normal_no_controls_-_reading_highlight.png
https://docs.myfridgeonline.com/_media/products/smrtcold/device_card_-_normal_no_controls_-_reading_highlight.png
https://docs.myfridgeonline.com/_media/products/smrtcold/device_card_-_normal_no_controls.png
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buttons.

The device's signal can be viewed here.

Device Configuration

Clicking on the top banner will route you to the Device Configuration page.

Device Controls

Clicking on the control icon will open the control menu.

https://docs.myfridgeonline.com/_media/products/smrtcold/device_card_-_normal_no_controls.png
https://docs.myfridgeonline.com/_detail/products/smrtcold/device_card_-_normal_no_controls_-_signal_highlight.png?id=products%3Asmrtcold%3Agetting_started
https://docs.myfridgeonline.com/_media/products/smrtcold/device_card_-_normal_no_controls_-_banner_highlight.png
https://docs.myfridgeonline.com/_media/products/smrtcold/device_card_-_normal_no_controls_-_controls_highlight.png


2025/07/24 04:56 29/46 User Manual

MyFridgeOnline - https://docs.myfridgeonline.com/

Here you can remotely control your device to perform different functions.

Clicking the power button will turn the unit off/on.

Clicking the defrost button will set the unit to defrost. This will also be visually indicated on the device
by the same icon.

https://docs.myfridgeonline.com/_detail/products/smrtcold/device_card-_normal_with_controls.png?id=products%3Asmrtcold%3Agetting_started
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https://docs.myfridgeonline.com/_media/products/smrtcold/device_card-_normal_with_controls_-_defrost_highlight.png
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Clicking on the continuous cycle button will set the unit to continuous cycle. This will also be visually
indicated on the device by the same icon.

Configuring Device Parameters

Navigation

This can be accessed via the Device Dashboard page.

Overview

On this page, device parameter information is displayed and can be interacted with. This page is split
up into 3 tabs, namely:

The Overview Tab1.
The View Tab2.
The Edit Tab3.

The Overview Tab

On this page, device parameter information can be viewed and interacted with.

https://docs.myfridgeonline.com/_media/products/smrtcold/device_card-_normal_with_controls_-_cycle_highlight.png
https://docs.myfridgeonline.com/_media/products/smrtcold/device_card-_normal_with_controls_-_cycle_highlight.png
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Filtering Parameters

Parameters can be filtered by their status by using the drop down menu. The search function also
allows further filtering.

Last Synced Time

The device's last synced time can be viewed here.

https://docs.myfridgeonline.com/_media/user_manual/dashboard/configure_parameters/config_page_overview_-_filter_highlight.png
https://docs.myfridgeonline.com/_media/user_manual/dashboard/configure_parameters/config_page_overview_-_filter_highlight.png
https://docs.myfridgeonline.com/_media/user_manual/dashboard/configure_parameters/config_page_overview_-_last_seen_highlight.png
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Parameter Information

Parameters are displayed either on chips or cards. Parameter information can be viewed here such as
the parameter name, current value of the parameter, the parameter status and alert configuration.
Displayed values are dependent on the template selected. The color of the parameter and the
message displayed indicates the parameter's status.

Alert configurations can be viewed here. The bell icon indications the number of alert groups set, the
monitor icon indicates the number of server alerts that are selected and a snooze icon indicates the
number of rules that are currently snoozed (this is based on the alert schedule). These are all
dependent on the number of rules set on the parameter.

https://docs.myfridgeonline.com/_media/user_manual/dashboard/configure_parameters/config_page_overview_-_sensor_highlight.png
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Editing Parameters

Parameters can be selected by clicking on them, the parameter color will change to pink to indicate
that it has been selected. Upon selection, a side menu will appear with a number of options
(depending on the user role).

Selecting Cancel will end the selection.

https://docs.myfridgeonline.com/_media/user_manual/dashboard/configure_parameters/config_page_overview_-_sensor_options_highlight.png
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Selecting Edit will open the Parameter Edit dialog.

https://docs.myfridgeonline.com/_media/user_manual/dashboard/view_device/sensor_dashboard_options_-_edit_highlight.png
https://docs.myfridgeonline.com/user_manual/dashboard/configure_sensors
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Selecting Graph will open the Parameter Graph dialog using the current selected parameters
information.

https://docs.myfridgeonline.com/_media/user_manual/dashboard/view_device/sensor_dashboard_options_-_graph_highlight.png
https://docs.myfridgeonline.com/user_manual/dashboard/graphing_sensors
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Selecting Delete will delete the selected parameters.

https://docs.myfridgeonline.com/_media/user_manual/dashboard/view_device/sensor_dashboard_options_-_delete_highlight.png
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The View Tab

The View tab contains read-only parameters displayed within a table. The table displays read-only
parameter values, short code,descriptions and alarm configurations. These are grouped and displayed
by parameter type.

https://docs.myfridgeonline.com/_media/user_manual/dashboard/configure_parameters/config_page.png
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Filtering Parameters

Parameters can be filtered by their category by using the drop down menu. The search function also
allows further filtering.

Alarm Configurations

Alert configurations can be viewed here. The bell icon indications the number of alert groups set, the
monitor icon indicates the number of server alerts that are selected and a snooze icon indicates the
number of rules that are currently snoozed (this is based on the alert schedule). These are all
dependent on the number of rules set on the parameter.

https://docs.myfridgeonline.com/_media/user_manual/dashboard/configure_parameters/config_page_-_filter_open_filter_highlight.png
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Editing Parameter Configuration

Parameters can be selected by clicking on the checkbox within the table, or by selecting an entire
category. Upon selection, a side menu will appear with a number of options (depending on the user
role). The options displayed here are the same as the Overview tab.

Setting Up Board Alerts

This a legacy option is only available on SMRT Cold devices

Alerts determined by the controller can be configured by clicking on the Defrost Probe and selecting
edit from the options menu. Adding the SMRT Cold Board alert rule to the Defrost Probe allows alerts
to be dispatched from the server when one or more controller alarms are triggered.

https://docs.myfridgeonline.com/_media/user_manual/dashboard/configure_parameters/config_page_-_parameters_selected_checbox_highlight.png
https://docs.myfridgeonline.com/_media/user_manual/dashboard/configure_parameters/config_page_-_parameters_selected_checbox_highlight.png
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To configure this rule follow the following steps:

Select the defrost probe from the parameter table.1.

Click the plus button and select the rule named SMRTCold Alerts.2.

Configure the alert by adding a delay. Delays determine the duration at which the value remain3.
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above or below the given configuration before an alert is dispatched.

Select an alert group.4.
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After you are done click save.5.
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The rule should then appear in the list. Click the submit button to finalize your update.6.



Last update: 2025/05/01 12:14 products:smrtcold:getting_started https://docs.myfridgeonline.com/products/smrtcold/getting_started

https://docs.myfridgeonline.com/ Printed on 2025/07/24 04:56

Alerts will now be dispatched to the users in the alert group when the controller's alarms are
triggered.

The Edit Tab

The Edit Tab contains contains editable parameters displayed within a table. The table displays
editable parameter values, short code and descriptions. These are grouped and displayed by
parameter type.

https://docs.myfridgeonline.com/_media/user_manual/dashboard/configure_parameters/config_page_-_edit_tab.png
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Filtering Parameters

Parameters can be filtered by their category by using the drop down menu. The search function also
allows further filtering.

Editing Parameter Values

Entering a value into the 'New Value' field will allow you to assign a new value to the parameter.
Doing so will also highlight the field in green if it is a valid value. The save button will allow you to
save this value once complete. Multiple fields can be edited simultaneously. Once complete, click the
Save button on the right side of the screen, to save your changes.
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Troubleshooting

On both the View and Edit tab, the following error messages may sometimes appear:

Value not found 
This indicates that a value for the current parameter has not been communicated to the
server. This can be avoided by ensuring the device syncs to the server during the first
uplink.

Profile incompatible 
This indicates the current profile configuration does not match the device type. This will
lead to incorrect data being stored and displayed.
This can be fixed by clicking on the error icon. A dialog will appear displaying a list of
profiles compatible with your device.
Select a valid profile and click 'Submit'.
Your device will then be updated to the correct configuration. To ensure all values are
received by the server, it is recommended to power cycle the device.
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